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Dans cette leçon, vous apprendrez à créer un assemblage à l'aide de fichiers existants.

Assembly Design

Sujets traités :

Etude de cas : Assembly Design
Objectif de la conception
Etapes du processus
Création d'un nouveau CATProduct
Assemblage dans le composant base 
Manipulation de la position du composant
Assemblage et contrainte totale des composants
Enregistrement de l'assemblage
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Présentation d'Assembly Design

Qu'est-ce qu'un assemblage ?

Un assemblage (aussi appelé un produit) est 
un document qui stocke une série de 
composants (pièces ou autres assemblages). 
Un assemblage utilise l'extension 
.CATProduct.

Les composants utilisés dans un assemblage 
peuvent être des composants pré-existants ou 
des composants créés dans l'assemblage. 

Comme une pièce, un assemblage contient un 
arbre des spécifications. L'arborescence 
affiche les composants insérés et les 
contraintes utilisées pour fixer les composants.
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Terminologie

A

B

C D

E

Certains termes sont propres à l'atelier Assembly Design :

Terme Description

A. Assemblage

B. Composant

C. Référence

D. Instances

E. Entité
active

Document qui contient une série de composants. Il 
possède l'extension de fichier ,CATProduct. Un 
assemblage est également appelé un produit.

Terme général pour tout modèle ajouté à un 
assemblage. Il peut s'agir d'une pièce ou d'un 
autre assemblage (sous-assemblage).

Identifie la pièce utilisée dans l'assemblage. 
Généralement, la référence est la même que le 
nom du fichier pièce pour le composant, mais 
elle peut être différente.

Chaque composant inséré dans un assemblage constitue 
une instance séparée. Par exemple, si la même pièce est 
insérée deux fois dans un assemblage, les deux 
exemplaires auront la même référence mais des numéros 
d'instance différents. Deux composants d'un assemblage 
ne peuvent avoir le même numéro d'instance.

L'entité en cours d'édition est appelée entité
active. Pour rendre une entité active, double-
cliquez dessus. L'entité active est en 
surbrillance.
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Etude de cas : Assembly Design

L'étude de cas de cette leçon porte sur le mécanisme de poignée, le sous-assemblage handle
mechanism (mécanisme poignée), qui fait partie du projet principal illustré ci-dessous. Cette 
étude de cas se focalise sur l'assemblage de fichiers pré-existants dans un nouvel 
assemblage.
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Objectif de la conception

� Corrigez le premier composant. 
• Bien que fixer le premier composant ne soit 

pas essentiel dans CATIA, cela constitue un 
bon entraînement de le faire.

� Contraignez entièrement tous les éléments.
• La contrainte entière des composants permet 

d'éviter des modifications involontaires. 

� Réutilisez les composants existants.
• La réutilisation de composants existants 

diminue le temps de conception.

Le sous-assemblage poignée doit 
correspondre aux pré-requis de l'objectif de 
conception suivant :
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Etapes du processus

1. Création d'un CATProduct.
2. Assemblage du composant base.
3. Manipulation de la position du composant et 

fixation.
4. Assemblage d'autres composants et contrainte 

complète de leurs positions.
5. Enregistrez l'assemblage.

Suivez ces étapes pour créer l'assemblage poignée :
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Création d'un nouveau CATProduct
Dans cette section, vous verrez ce qu'est un assemblage et comment créer un nouveau 
fichier produit.

Suivez ces étapes :

1. Création d'un 
CATProduct.

2. Assemblage du composant
base. 

3. Manipulation de la position du 
composant

4. Assemblage et contrainte 
totale des composants.

5. Enregistrez l'assemblage
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Définition d'un nouveau document d'assemblage

A

C

A. Sélectionnez le menu Start > 
Mechanical Design > Assembly Design 
(Démarrer > Conception Mécanique > 
Assembly design).

B. Sélectionnez le menu File > New (Fichier 
> Nouveau) et sélectionnez Product dans 
la fenêtre New (Nouveau).

C. Sélectionnez l'icône Nouveau et 
sélectionnez Product dans la fenêtre New 
(Nouveau).

Les assemblages sont créés dans l'atelier 
Assembly Design. Utilisez l'une des méthodes 
suivantes pour accéder à l'atelier Assembly
Design.

B
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Affectation de propriétés de produit

1 2

3

1. Cliquez sur le nom de l'assemblage dans l'arbre des 
spécifications.

2. Cliquez avec le bouton droit de la souris et 
sélectionnez Properties (Propriétés).

3. Spécifiez la référence dans le champ Part Number
(Référence) et toutes les autres informations 
pertinentes décrivant l'assemblage.

4. Cliquez sur OK pour fermer la boîte de dialogue 
Properties (Propriétés).

Suivez ces étapes pour ajouter des 
informations de description au nouveau 
document d'assemblage :
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Assemblage du composant de base
Dans cette section, vous apprendrez à ajouter un composant base au nouveau produit.

Suivez ces étapes :

1. Création d'un CATProduct.
2. Assemblage du

composant base. 
3. Manipulation de la position du 

composant
4. Assemblage et contrainte 

totale des composants.
5. Enregistrez l'assemblage
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Ajout de composants (1/2)

A

B

A. Menu contextuel
• Cliquez avec le bouton droit sur 

l'assemblage qui recevra le composant 
et utilisez le menu contextuel pour 
insérer le composant. C'est la méthode 
la plus rapide pour insérer un 
composant.

B. Outils de Product Structure
• Sélectionnez l'assemblage dans l'arbre 

de spécifications et utilisez les icônes 
de la barre d'outils Outils de Product 
Structure.

Vous pouvez ajouter un composant à un 
assemblage de l'une des trois façons 
suivantes : menu contextuel, Outils de Product 
Structure et menu Insertion.
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Ajout de composants (2/2)

C. Menu Insert (Insertion)
• Sélectionnez l'assemblage dans 

l'arbre des spécifications et 
utilisez le menu Insert 
(Insertion).
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Insertion d'un composant existant (1/2)

B

C

A

A. Cliquez avec le bouton droit de la 
souris sur l'assemblage et 
sélectionnez Existing Component 
(Composant existant)
OU

B. Sélectionnez l'assemblage dans 
l'arbre des spécifications et cliquez 
sur l'icône Composant existant.
OU

C. Sélectionnez l'assemblage dans 
l'arbre des spécifications et 
sélectionnez le menu Insert > 
Existing Component (Insertion > 
Composant existant).

Lorsque vous ajoutez des pièces ou 
assemblages existants comme 
composants, leurs fichiers 
correspondants ne sont pas copiés dans 
l'assemblage ; ils sont seulement 
référencés par l'assemblage. 

Suivez ces étapes pour ajouter un 
composant à un assemblage :
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Insertion d'un composant existant (2/2)

D

E

F

D. Sélectionnez le composant dans la 
fenêtre File Sélection (Sélection de 
fichier).

E. Cliquez sur Open (Ouvrir).

F. Le composant est ajouté à l'assemblage.

Suivez ces étapes pour ajouter un 
composant à un assemblage (suite) :
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Affectation de propriétés de composant (1/2)

2

Nom de 
l'instance

Référence

3

5

6

1. Cliquez sur Tools > Options (Outils 
> Options).

2. Sélectionnez Infrastructure > 
Structure du produit et affichez 
l'onglet Nodes Customization
(Personnalisation des noeuds).

3. Cochez l'option Customized Display 
(Affichage personnalisé) dans 
Product instance, reference loaded
(Instance de produit, référence 
chargée). 

4. Cliquez sur Configure (Configurer).
5. Videz la liste existante et 

sélectionnez le nom de l'instance 
(#IN#).

6. Cliquez sur Close (Fermer).
7. Cliquez sur OK.

Une fois les composants insérés dans un produit, vous 
pouvez personnaliser leur affichage et leurs propriétés. 
Par défaut, la référence et le nom de l'instance s'affichent 
dans l'arbre de spécifications pour chaque composant. 

Suivez ces étapes pour personnaliser l'affichage dans 
l'arbre des spécifications :
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Affectation de propriétés de composant (2/2)

1

2

3

1. Cliquez avec le bouton droit de la souris sur le composant.
2. Cliquez sur Propriétés (Propriétés) dans le menu 

contextuel.
3. Spécifiez les informations nécessaires, comme Instance 

name (Nom de l'instance) et Description.

Les propriétés du composant inséré peuvent aussi être modifiées. 
Suivez ces étapes pour modifier les propriétés du composant :
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Manipulation de la position du composant
Dans cette section, vous apprendrez à déplacer un composant et à fixer sa position 
dans l'espace.

Suivez ces étapes :

1. Création d'un CATProduct.
2. Assemblage du composant

base. 
3. Manipulation de la 

position du composant.
4. Assemblage et contrainte 

totale des composants.
5. Enregistrez l'assemblage
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A propos de la boussole

A

B

A. Dans l'exemple du haut, l'assemblage 
entier pivote autour de l'axe X lorsque la 
boussole est sélectionnée comme illustré. 
La rotation est temporaire car elle n'est 
pas stockée dans les documents CATPart
ou CATProduct. Vous modifiez seulement 
le point de vue.

B. Dans l'exemple du bas, un composant 
pivote librement autour de l'axe X. Si ce 
composant n'est pas contraint, la nouvelle 
position est stockée dans les documents 
CATProduct.

Une fois les composants insérés dans 
l'assemblage, ils peuvent être manipulés en 
utilisant la boussole pour déplacer et faire 
pivoter l'assemblage en entier, ou en faisant 
simplement glisser et pivoter ses composants.
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Positionnement de la boussole pour déplacer un composant

3

1

2

1. Déplacez le pointeur sur le petit carré
rouge de la boussole. L'aspect du pointeur 
change.

2. Appuyez sur le bouton gauche de la souris 
et maintenez-le enfoncé pour faire glisser 
la boussole. La forme de la boussole 
change pendant son déplacement. 

3. Si le composant est sélectionnable, la 
boussole prend l'orientation de l'élément 
géométrique en dessous d'elle.  Pour 
sélectionner le composant, relâchez le 
bouton gauche de la souris.

Avant de pouvoir déplacer un composant en 
utilisant la boussole, vous devez positionner la 
boussole sur le composant. 

Suivez ces étapes pour positionner la 
boussole :
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Déplacement d'un composant en utilisant la boussole (1/2)

Suivez ces étapes pour déplacer un composant en 
utilisant la boussole :

1. Placez la boussole sur un composant. 

2. Sélectionnez le type de mouvement que 
vous voulez en déplaçant le pointeur 
sur la boussole. L'élément en 
surbrillance de la boussole indique le 
mouvement disponible :

a. Translation suivant un axe
b. Translation suivant un plan

c. Rotation autour d'un axe 
d. Rotation autour de l'origine de la 

boussole.

3. Faites glisser le composant vers une 
nouvelle position.

2a

2b

2c

2d

1

3
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Déplacement d'un composant en utilisant la boussole (2/2)

4. Pour déplacer le composant d'une 
distance précise, procédez comme suit 
:
a. Placez la boussole sur un 

composant.
b. Cliquez avec le bouton droit de la 

souris sur le petit carré rouge de la 
boussole et cliquez sur Edit 
(Edition).

c. Définissez l'incrémentation de la 
translation Along W à [100mm].

d. Cliquez sur la flèche vers le haut 
pour définir l'incrémentation 
positive.

4a

4b

4c 4d
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Alignement de composants

2

3

1

1. Cliquez sur l'icône Alignement dans la 
barre d'outils Move (Déplacement).

2. Sélectionnez la surface inférieure du 
boulon.

3. Sélectionnez la surface supérieure de la 
base.

Vous pouvez déplacer des composants sans 
recourir à la boussole en utilisant l'outil Snap
(Alignement). La fonctionnalité implique la 
sélection d'entités entre les composants 
comme références pour les aligner 
ensemble. 
Pour aligner un composant, procédez comme 
suit :
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Fixation d'un composant dans l'espace (1/2)

1
2

3

1. Cliquez sur l'icône Fixe un composant dans la 
barre d'outils Contraintes.

2. Sélectionnez le composant dans l'arborescence 
ou dans la géométrie.

3. Le composant est fixé dans l'espace.

Après l'insertion du composant base, ce dernier peut 
être laissé « flottant » dans l'espace (sans contraintes), 
mais c'est un bon entraînement de fixer ce composant. 
La fixité de ce composant servira de référence pour le 
positionnement de tous les autres composants qui 
seront assemblés plus tard. Les composants fixés 
dans l'espace retournent à leur position lorsque les 
contraintes sont mises à jour (c'est-à-dire régénérées).

Suivez ces étapes pour fixer un composant dans 
l'espace :
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Fixation d'un composant dans l'espace (2/2)

Après la mise à jour, 
la position du 
composant est 

réévaluée.

Le composant fixé est 
déplacé avec la 

boussole.

Une fois que vous avez fixé un composant, 
vous pouvez toujours temporairement 
manipuler sa position dans l'assemblage. 
Après la mise à jour de l'assemblage, la 
contrainte sera réévaluée.

La boussole est placée 
sur le composant qui est 

fixé dans l'espace.
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Fixation d'un composant (1/2)

2

3

1

4

1. Sélectionnez l'icône Fixe un composant pour 
créer la contrainte.

2. Double-cliquez sur la contrainte Fix (Fixe) 
existante.

3. Cliquez sur le bouton More>> (Plus>>). 
4. Décochez l'option Fix in Space (Fixité absolue).

Lorsque vous commencez à ajouter des contraintes 
à un assemblage, vous devez d'abord avoir un 
composant fixé, puis placer les autres composants 
par rapport à celui-ci. Si le composant est seulement 
« fixé » (et non « fixé dans l'espace »), vous pouvez 
modifier sa position, l'assemblage restera cohérent 
en terme de contraintes.
Suivez ces étapes pour fixer un composant :
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Fixation d'un composant (2/2)

AB

A. Faites glisser le composant avec la boussole 
vers une nouvelle position. Le composant 
situé au-dessus de la boussole est fixé mais 
pas fixé dans l'espace. 

B. Dans cet exemple, vous voyez que les 
composants rouge et bleu se déplacent par 
rapport aux contraintes qui leur ont été
appliquées.

L'exemple suivant illustre le concept d'un 
composant base qui est fixé, mais non fixé dans 
l'espace.

Après la mise à jour, 
la position du 
composant est 

réévaluée.
Le composant fixé est 

déplacé avec la 
boussole.

La boussole est placée 
sur le composant qui est 

fixé.
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Réorganisation d'une structure de produit

Arborescence originale Arborescence réorganisée

Vous pouvez réorganiser les composants dans l'arbre des spécifications pour « coller » aux pré-
requis de conception.

a

b
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Réorganisation d'une structure de produit (1/2)

1

2

1. Activez l'outil en sélectionnant le menu 
Edition > Composants > Réorganisation 
de l'arbre ou en cliquant sur l'icône 
Réorganisation de l'arbre.

2. Sélectionnez le produit dans lequel vous 
voulez réorganisez les composants.

3. Sélectionnez le composant que vous 
voulez réorganiser.

4. Sélectionnez les icônes flèches pour 
changer la position du composant 
sélectionné dans l'arborescence.

5. Cliquez sur OK.

L'outil Réorganisation de l'arbre vous permet 
de réorganiser les composants dans l'arbre 
des spécifications pour répondre à vos 
besoins. 

Suivez ces étapes pour réorganiser les 
composants :

3

4

5
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Réorganisation d'une structure de produit (2/2)

1
2

3

4

1. Sélectionnez un composant à réorganiser.

2. Cliquez sur l'icône Déplace le produit 
sélectionné.

3. Sélectionnez le composant sous lequel 
vous voulez positionner le composant 
sélectionné.

4. Cliquez sur Apply (Appliquer).

5. Cliquez sur OK.

Vous pouvez aussi déplacer un composant en 
utilisant l'outil Graph Tree Reordering
(Réorganisation de l'arbre):

5
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Copier/coller d'un composant

1

3

2

4

1. Cliquez avec le bouton droit de la souris 
sur le composant.

2. Cliquez sur Copy (Copier) dans le menu 
contextuel.

3. Cliquez avec le bouton droit de la souris 
sur l'assemblage dans lequel vous voulez 
coller le composant.

4. Cliquez sur Paste (Coller) dans le menu 
contextuel.

Un assemblage peut nécessiter plus d'une 
instance d'un composant. Les options Copy 
(Copier) et Paste (Coller) fournissent une 
méthode rapide pour dupliquer un composant. 
Suivez ces étapes :
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Duplication de plusieurs instances d'un composant

2

3

4

4

5

5

1

1. Cliquez sur l'icône Définition de la multi-
instanciation dans la barre d'outils Outils de 
Product Structure.

2. Sélectionnez un composant. 
3. Spécifiez le nombre d'instances et 

l'espacement entre elles. 
4. Sélectionnez une direction en utilisant une 

arête d'un composant ou utilisez les 
directions X, Y, Z de l'axe. 

5. Cliquez sur OK pour terminer le composant.

Les composants peuvent être dupliqués suivant 
une droite en utilisant l'outil Multi-instanciation. 
Lorsque vous utilisez cet outil pour créer 
plusieurs instances d'un composant contraint, 
soyez conscient que les instances résultantes ne 
sont pas automatiquement contraintes.
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Duplication de composants en utilisant une répétition existante 
(1/3)

• Avec l'option re-use the original component (réutiliser 
le composant original), le composant original est 
positionné sur le motif, mais reste à la même position 
dans l'arbre des spécifications.

• Avec l'option créer une nouvelle instance, le 
composant original reste à la même position dans l'arbre 
des spécifications, et une nouvelle instance du 
composant est créée sur le motif.

• Avec l'option couper/coller le composant original, le 
composant original devient la première instance dans le 
motif, et est déplacé dans l'arborescence.

Les motifs peuvent être utilisés pour automatiser la 
duplication d'un composant et de ses contraintes. 
Lorsque vous utilisez l'icône Reuse Pattern (Réutilise 
un motif), la boite de dialogue Instantiation on a 
Pattern (Instanciation sur un motif) s'ouvre.

L'option Keep Link with the Pattern (Garder le lien 
avec le motif), si activée, garde une association entre 
les composants instanciés et le motif.

La fenêtre affiche aussi le nom du motif, le nombre 
d'instances à créer et le nom des composants à répéter.

Le composant d'origine peut être traité de trois façons :
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Duplication de composants en utilisant une répétition existante 
(2/3)
Vous pouvez utiliser la commande Reuse Pattern (Réutilise un motif) pour créer 
rapidement plusieurs instances d'un composant qui est assemblé par rapport au composant 
attaché d'un motif existant.
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Duplication de composants en utilisant une répétition existante 
(3/3)
Lorsque vous modifiez le nombre d'instances dans le motif de conception, le motif 
d'assemblage doit être mis à jour. Lorsque vous mettez à jour l'assemblage, le nombre 
d'instances du composant se met à jour aussi.
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Composants d'un catalogue (1/2)
1

2

3

4

1. Sélectionnez l'icône Navigateur de 
catalogues.

2. Localiser le bon catalogue.
3. Sélectionnez le chapitre approprié dans le 

catalogue.
4. Sélectionnez la famille voulue.

Un catalogue est constitué d'une série de 
composants en lecture seule qui peuvent être 
utilisés dans un assemblage. CATIA possède 
une bibliothèque d'attaches standards et de 
pièces communes. 

Pour insérer un composant à partir d'un 
catalogue, procédez comme suit :
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Composants d'un catalogue (2/2)

5

6

5. Sélectionnez le composant voulu.
6. Cliquez sur OK dans la boîte de dialogue 

Preview (Aperçu).

Suivez ces étapes pour insérer un composant 
d'un catalogue (suite) :
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Recommandation sur les pièces symétriques

Dans un produit, comme un véhicule, de 
nombreuses pièces peuvent être symétriques 
par rapport au plan vertical passant par l'axe 
longitudinal (par exemple, le capot ou le pare-
chocs avant ou arrière). 

Pour gagner du temps de modélisation et de 
l'espace de stockage, il suffit de modéliser 
uniquement la moitié de ce type de pièce. Il 
peut s'agir du côté gauche ou droit, selon les 
conventions appliquées par l'entreprise. 

Un système PDM vous permet d'appliquer une 
symétrie sans duplication de données. Il sera 
possible de créer une référence de la pièce 
résultante qui intègre l'original et la géométrie 
symétrique. 
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Assemblage et contrainte totale des composants
Dans cette section, vous apprendrez à insérer d'autres composants et à les contraindre 
dans l'assemblage.

Suivez ces étapes :

1. Création d'un CATProduct.
2. Assemblage du composant

base. 
3. Manipulation de la position du 

composant.
4. Assemblage et 

contrainte totale des 
composants.

5. Enregistrez l'assemblage
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Degrés de liberté

Lorsque des composants sont insérés pour la première fois dans un assemblage, ils peuvent être 
translatés et tournés dans toutes les directions. Si des contraintes sont appliquées à ces 
composants, leurs degrés de liberté diminuent. Idéalement, chaque composant d'un assemblage 
doit posséder zéro degré de liberté. Ceci garantit le maintien de l'objectif de conception en cas de 
modifications apportées à l'assemblage. Si l'assemblage conserve des degrés de liberté, des 
mouvements non désirés risquent de se produire entre composants.

Pour vérifier les degrés de liberté d'un composant, cliquez avec le bouton droit de la souris sur le 
composant et sélectionnez Objet x > Degrés de liberté du composant dans le menu contextuel. 
Chaque degré de liberté restant apparaîtra dans la boîte de dialogue Degrees of Freedom
Analysis (Analyse des degrés de liberté).

Selon 
config.
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Configuration des contraintes d'assemblage

A B

A. Barre d'outils Constraints (Contraintes) 
B. Menu Insert (Insertion)

On enlève des degrés de liberté d'un 
composant en lui ajoutant des contraintes. 
Comme les contraintes d'esquisse, les 
contraintes d'assemblage positionnent 
également la géométrie par rapport à des 
éléments existants (des composants existants, 
dans le cas d'un assemblage). 

Des contraintes sont ajoutées à l'assemblage 
en utilisant l'une des méthodes suivantes :
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Contraintes d'assemblage
1

2

3
4

1. Fixez dans l'espace un composant dans 
l'assemblage. Il sera le point de départ.

2. Avec la boussole, faites glisser et pivoter les 
composants pour les positionner 
approximativement. Cela facilitera le 
processus de positionnement des 
contraintes.

3. Positionnez chaque composant précisément 
par sélection et application de contrainte(s) 
appropriée(s). 

4. Pour vérifier le résultat, mettez à jour 
l'assemblage. Il placera les composants 
selon la position souhaitée.

Les contraintes d'assemblage sont utilisées pour 
positionner les composants dans un assemblage. 

Suivez ces étapes pour ajouter des contraintes 
d'assemblage :
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Contraintes disponibles et leurs symboles

Le tableau suivant répertorie les symboles représentant les contraintes que vous pouvez définir 
entre composants :

Contraintes
Symbole utilisé
sur la géométrie

Symbole affiché
dans l'arbre de spécifications

Coïncidence

Contact

Décalage

Angle plan

Parallélisme

Perpendicularité

Fixité
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Définition d'une contrainte de coïncidence (1/2)

coaxial

coplanaire

points fusionnés

1

2

3

1. Cliquez sur l'icône Contrainte de 
coïncidence. 

2. Sélectionnez les deux éléments définissant 
la contrainte. 

3. La contrainte est créée et les éléments 
sont alignés après la mise à jour.

La contrainte de coïncidence crée un 
alignement qui peut être de type coaxial, 
coplanaire ou points fusionnés. 
Suivez ces étapes pour appliquer une 
contrainte de coïncidence :
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Définition d'une contrainte de coïncidence (2/2)

1

2

3

1. Cliquez sur l'icône Contrainte de 
coïncidence.

2. Sélectionnez deux plans comme éléments 
géométriques pour la contrainte.

3. Cliquez sur l'une des flèches vertes pour 
inverser l'orientation du composant à
déplacer.

4. Cliquez sur OK quand l'orientation est 
correcte.

5. La contrainte est créée et les éléments 
sont alignés après la mise à jour.

Si l'alignement a pour but de rendre deux 
surfaces coplanaires, CATIA donne un choix 
d'orientation avec deux flèches vertes. 
Suivez ces étapes pour définir l'orientation :
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Définition d'une contrainte de contact

1

2

3

La contrainte de contact connecte deux plans 
ou faces. 

Avec la contrainte de contact, vous prenez en 
compte le côté matériau, de sorte que 
l'orientation de la pièce soit calculée 
automatiquement.

Suivez ces étapes pour appliquer cette 
contrainte :

1. Cliquez sur l'icône Contrainte de contact.

2. Sélectionnez les deux éléments définissant 
la contrainte.

3. La contrainte est créée et les éléments 
sont mis en contact après la mise à jour.
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Définition d'une contrainte de distance

4

1

3

2

Contrainte de distance 
avec orientation 
identique.

Contrainte de distance avec 
orientation opposée.

5

1. Cliquez sur l'icône Décalage.
2. Sélectionnez les deux éléments auxquels 

la contrainte sera appliquée.
3. Spécifiez la valeur dans Offset (Décalage).
4. Sélectionnez la valeur dans Orientation 

(Same (Identique) ou Opposite 
(Opposée)), en cliquant sur la flèche verte 
ou en sélectionnant une option dans la 
liste Orientation.

5. Cliquez sur OK.
6. La contrainte est créée et les éléments 

sont positionnés après la mise à jour.

La contrainte de distance définit une distance 
entre deux éléments. Suivez ces étapes pour 
appliquer cette contrainte :
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Création d'une contrainte angulaire (1/2)

1

2

3

4

5

1. Cliquez sur l'icône Angle.
2. Sélectionnez les deux éléments auxquels 

la contrainte sera appliquée.
3. Sélectionnez le type de contrainte (ici 

Angle) dans la fenêtre Constraint
Properties (Propriétés des contraintes).

4. Spécifiez la valeur d'angle.
5. Cliquez sur OK.
6. La contrainte est créée et les éléments 

sont positionnés après la mise à jour.

La contrainte Angle vous permet de définir un 
angle entre les composants. Suivez ces 
étapes pour appliquer cette contrainte :
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Création d'une contrainte angulaire (2/2)

1

2

3

Contrainte Parallélisme 
avec l'orientation 
Identique.

Contrainte Parallélisme avec 
l'orientation Opposée.

1. Cliquez sur l'icône Angle.
2. Sélectionnez deux plans comme éléments 

géométriques pour spécifier la contrainte.
3. Sélectionnez les options Parallelism

(Parallélisme) ou Perpendicularity
(Perpendicularité).

4. Si l'option Parallelism (Parallélisme) est 
sélectionnée, spécifiez l'orientation. 

5. Cliquez sur OK.

Vous pouvez aussi définir des parallélismes et 
perpendicularités entre deux éléments à l'aide 
de la contrainte Angle. Dans le cas du 
parallélisme, vous pouvez choisir entre les 
orientations Same (Identique) ou Opposite 
(Opposée). 

Suivez ces étapes pour appliquer cette 
contrainte :
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Fixité de composants ensemble

1

2

La contrainte Fixité relative vous permet de 
contraindre des composants pour qu'ils se 
déplacent comme une seule entité. 
Suivez ces étapes pour appliquer cette 
contrainte :
1. Cliquez sur l'icône Fixité relative.
2. Sélectionnez les composants à fixer 

ensemble. Vous pouvez sélectionner plus 
de deux composants.

La fenêtre Fix Together (Fixité relative) vous 
permet d'afficher une liste des composants 
que vous avez sélectionnés.

Vous pouvez retirer des éléments de la liste en 
sélectionnant les éléments dans le modèle ou 
dans la liste.
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Recommandation sur les contraintes (1/2)

Pendant le cycle de vie d'un produit, les pièces 
sont modifiées ou remplacées par de 
nouvelles versions. Il existe donc un risque 
que la géométrie n'existe plus après une 
modification. 

Si les pièces sont positionnées avec des 
contraintes basées sur la géométrie d'une 
pièce, elles risquent de devenir incorrectes et 
de perdre leur positionnement.

Pour éviter ceci et obtenir des pièces 
correctement positionnées même lorsqu'elles 
sont remplacées par une nouvelle version, 
vous pouvez positionner la pièce avec des 
contraintes entre le repère des pièces de 
l'assemblage (chaque pièce étant positionnée 
dans son propre repère plutôt que dans le 
repère global). 

Contrainte basée sur la 
géométrie

Après le remplacement, la 
contrainte génère une erreur et la 
position n'est pas conservée.
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Recommandation sur les contraintes (2/2)

Le positionnement basé sur un axe est 
également utile en cas de réutilisation de 
pièces provenant d'anciens projets 
(transfert) : 

Imaginez que vous conceviez une nouvelle 
pièce uniquement à des fins d'étude 
(géométrie temporaire) : vous positionnez 
cette pièce à l'aide de contraintes entre 
repères. 

Vous finissez par remplacer cette pièce 
d'étude par une ancienne pièce : celle-ci 
contient également le même repère, ce qui 
vous évite de recommencer le 
positionnement. Si l'axe utilisé pour le 
positionnement est publié avec les mêmes 
noms, les contraintes sont automatiquement 
résolues.

La pièce transférée est bien positionnée 
même si sa géométrie est différente de celle 
de la géométrie d'étude.

Contrainte basée sur un 
axe

Après le remplacement, les 
contraintes sont mises à jour et la 
position est conservée.
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Règles de contrainte

A. Vous ne pouvez appliquer des contraintes 
qu'entre des composants enfants du 
composant actif. 

B. Vous ne pouvez pas définir de contraintes 
entre deux éléments géométriques 
appartenant au même composant.

C. Vous ne pouvez pas appliquer de 
contraintes à deux composants appartenant 
au même sous-assemblage si le sous-
assemblage n'est pas un composant actif.

CATIA impose automatiquement les règles 
suivantes gouvernant les contraintes :

A

B

C



Principes de base CATIA V5- Leçon 8 : Assembly Design
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                            8-67

Assistant d'assemblage

A

A. Vous essayez de contraindre un 
composant qui n'appartient pas au 
produit actif. (Dans l'exemple 
présenté, si vous sélectionnez la 
géométrie BigScrew, vous recevez 
cet avertissement.)

B. Vous essayez de contraindre deux 
éléments qui appartiennent au 
même composant. (Dans l'exemple 
présenté, si vous sélectionnez un 
élément Axis et un élément 
AxisNut, vous recevez cet 
avertissement.)

C. Vous essayez de sélectionner des 
éléments non publiés alors que 
l'option “Select Published element
only” (Sélectionner une géométrie 
publiée uniquement) est activée. 
(Dans l'exemple présenté, si vous 
essayez de sélectionner un élément 
géométrique non publié, vous 
recevez cet avertissement.)

L'assistant d'assemblage affiche un 
avertissement si vous faites des 
erreurs lors de la définition de 
contraintes. Les avertissements 
apparaissent dans les cas suivants 
:

C

B
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Mise à jour des contraintes (1/2)

A

B

C

Lorsque vous mettez à jour un assemblage, 
CATIA réapplique toutes les contraintes aux 
composants. Vous avez le choix entre mettre à
jour tout l'assemblage ou ne mettre à jour que 
des composants spécifiques. Les contraintes 
nécessitant une mise à jour sont indiquées dans 
l'arbre des spécifications et dans le modèle. 
L'exemple illustré possède une contrainte qui 
doit être mise à jour :

A. L'icône de la contrainte dans l'arborescence 
n'est pas mise à jour (notez le petit symbole 
de mise à jour qui l'accompagne).

B. La contrainte apparaît en noir.

C. Ces deux signaux indiquent que 
l'assemblage doit être mis à jour. Ce sera 
fait grâce à l'outil Mise à jour complète .



Principes de base CATIA V5- Leçon 8 : Assembly Design
�����������	
�����


                                                                                                                                                                                                                                                                                                                                                                            8-69

Mise à jour des contraintes (2/2)

Mise à jour 
nécessaire

Mise à jour 
effectuée

Mise à jour 
nécessaire

Mise à jour 
effectuée

B

A

A. Pour mettre à jour toutes les contraintes et 
pièces dans l'assemblage, sélectionnez 
l'icône Mise à jour complète dans la barre 
d'outils Mise à jour.

B. Pour mettre à jour une contrainte 
individuelle, cliquez avec le bouton droit de 
la souris sur une contrainte dans l'arbre 
des spécifications ou sur le modèle, puis 
sélectionnez Update (Mise à jour) dans 
l'arbre des spécifications.

Vous pouvez mettre à jour toutes les 
contraintes ou le faire individuellement, en 
utilisant l'une des méthodes suivantes :
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Options de mise à jour des contraintes d'assemblage

Sélectionnez le menu Tools > Options > Mechanical Design > Assembly Design (Outils 
> Options > Conception Mécanique > Assembly Design) pour accéder aux options de 
mise à jour pour un assemblage. A partir de l'onglet General (Général) vous pouvez choisir 
de mettre à jour l'assemblage automatiquement ou manuellement (ce qui nécessite 
l'utilisation de l'outil Mise à jour). Vous pouvez aussi définir l'option Update propagation 
depth (Mettre à jour la profondeur de propagation) pour que la mise à jour se fasse au 
niveau actif de l'assemblage ou à tous les niveaux.
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Gestion des erreurs de mise à jour

A

A. Cliquez sur le bouton Edit (Editer) pour 
afficher la fenêtre Constraint Definition
(Définition de contrainte). La contrainte 
peut être éditée ou reconnectée à un 
élément différent.

B. Cliquez sur le bouton Deactivate
(Désactiver) pour désactiver une 
contrainte sans la supprimer. Cela vous 
permet de réexaminer le problème plus 
tard. 

C. Cliquez sur Isolate (Isoler) pour supprimer 
les références d'un composant d'une autre 
géométrie. 

D. Cliquez sur Delete (Supprimer) pour 
retirer la totalité de la contrainte 
incompatible.

Lorsque vous mettez à jour un assemblage, 
les contraintes sont analysées quant aux 
conflits. CATIA affichera la fenêtre Diagnosis
(Diagnostic) si des problèmes apparaissent 
(par exemple, composants surcontraints). 
Vous pouvez sélectionner un conflit dans la 
boîte de dialogue Update Diagnosis
(Diagnostic de la mise à jour) et effectuer 
l'une des actions suivantes :

B
C

D
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Enregistrement de l'assemblage
Dans cette section, vous apprendrez à enregistrer un assemblage.

Suivez ces étapes :

1. Création d'un CATProduct.
2. Assemblage du composant

base. 
3. Manipulation de la position du 

composant.
4. Assemblage et contrainte 

totale des composants.
5. Enregistrement de 

l'assemblage.
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Enregistrement d'un document d'assemblage

Les quatre options suivantes (situées dans le menu 
Fichier) peuvent être utilisées pour enregistrer un 
assemblage et des documents enfants :

A. L'option Save (Enregistrer) enregistre les 
documents du composant actif et les 
documents enfants du document actif.

B. L'option Save As (Enregistrer sous) est 
similaire à l'option Save (Enregistrer), sauf 
que vous pouvez aussi spécifier un nom et un 
répertoire pour le document actif.

C. L'option Save All (Enregistrer tout) 
enregistre tous les documents ouverts qui ont 
été modifiés depuis le dernier enregistrement.

D. L'option Save Management (Gestion des 
enregistrements) vous invite à enregistrer 
tous les documents ouverts et tous les enfants 
de ces documents ; vous pouvez également 
contrôler leurs noms et leurs emplacements.

Pour chacune de ces options, seuls les documents 
modifiés sont enregistrés.
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Enregistrement d'un document avec un autre nom

1

4

3

1. Activez le document à enregistrer. Dans 
cet exemple, le document CATProduct
actif et tous les documents enfants 
modifiés seront enregistrés.

2. Cliquez sur File > Save As (Fichier > 
Enregistrer sous).

3. Spécifiez le nom de fichier dans File name
(Nom de fichier) et un répertoire.

4. Indiquez si vous voulez regénérer les 
identifiants internes.

5. Cliquez sur Save (Enregistrer).

L'option Save As (Enregistrer sous) vous permet 
de spécifier un nom de fichier et un répertoire pour 
enregistrer le fichier. Vous pouvez créer un nouveau 
document avec de nouveaux identifiants internes. 
Suivez ces étapes pour enregistrer un document en 
utilisant cette option :
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Tous les documents ouverts 
modifiés sont enregistrés, 
quel que soit le document actif.

Enregistrement de tous les documents modifiés

2

3

L'option Save All (Enregistrer tout) fournit une 
méthode simple pour enregistrer tous les 
documents modifiés qui ne sont ni nouveaux ni en 
lecture seule. Suivez ces étapes pour enregistrer 
un document en utilisant cette option :
1. Sélectionnez le menu File > Save All (Fichier > 

Enregistrer tout).
2. Si tous les documents modifiés depuis le dernier 

enregistrement ne sont ni nouveaux ni en lecture 
seule, aucun message n'apparaîtra et CATIA les 
enregistrera. Si certains documents modifiés 
depuis le dernier enregistrement sont nouveaux 
(càd tout juste créés) ou sont des fichiers en 
lecture seule, vous recevrez un message 
indiquant que les fichiers ne peuvent pas être 
enregistrés automatiquement. 

3. Après avoir cliqué sur OK, CATIA vous donnera 
accès à la commande Save All (Enregistrer 
tout).
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Gestion des enregistrements

L'outil Save Management (Gestion des enregistrements) est utile pour l'enregistrement de 
tous les documents modifiés ou liés sous des noms et des répertoires (UNIX) / dossiers 
(Windows) sélectionnés.
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Pour résumer...

� Création d'un CATProduct.
� Assemblage du composant base.
� Manipulation de la position du composant 

et fixation.
� Assemblage d'autres composants et 

contrainte complète de leurs positions.
� Enregistrement de l'assemblage.

En utilisant les connaissances acquises 
pendant cette leçon, vous devez être capable 
de créer l'assemblage handle mechanism
(mécanisme poignée).

Vous serez invité à exécuter les opérations 
suivantes :




